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OCAF Agency User Guide

Overview

This article describes how to enter an inquiry for Foster Care and/or Adoption in the Ohio
Certification for Agencies and Families (OCAF) system and have prospective resource families
complete a JFS 01691.

Getting Started

To gain access to the OCAF system, you must submit a completed JFS 7078 to
SACWIS Access@ijfs.ohio.gov. Enter the appropriate role on the form based on the type of
agency you are employed by:

Role Name Agency Type Access
EIDMX_JFS_S - OFC — OCAF Private Agency Worker Private Agency
EIDMX_JFS_C - OFC — OCAF County Agency Worker Public Agency

Private agency users will require a paper 7078 to be submitted while the digital 7078 can be
utilized by public agencies users. Upon approval, an email will be sent by the Automated
Systems Help Desk with details on how to log-in to OCAF.

MyOhio Access

After the user is properly provisioned for access to OCAF, begin by accessing MyOhio.
Navigate to the apps. Locate and click on the tile for JFS Salesforce Apps.

w

salesforce

JFS Salesforce Apps

Any JFS Salesforce applications are
available through this tile

Details Open App

Helpful Hints About the OCAF System

e You may use the web browser back arrow button to return to the previous screen or
navigate between record tabs within Salesforce.
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e All items in blue font contain a hyperlink to something else. Click on it to navigate to the
corresponding information page.

e On the Accounts, Contacts, Individual Applications, and Cases (represents
Inquiries) page, each contains a list view that can be changed and pinned for your
convenience. The drop-down arrow next to the list can be changed. To keep that list,
click the pin symbol.

Individual Applications
- All of My Agency's Applications v{ *

44 itemn LIST VIEWS

All Individual Applications

1 +  All of My Agency's Applications (Pinned list)

Navigating OCAF

After logging into the system, the tabs at the top will guide you through the different work items

— Dy of
Oh 10 Jul?:n?d“g: rtnih,r Services

[ X X ] & o "
<+s  Ohio Certification f... Home
. . Home
H Individual Applications
- All of My Agency's A
yAg y | Accounts
3+ items - Sorted by Application Mumbs stions - Record Ty
| Contacts
1
Application Nu... §* Applicatio...
a Individual Applications
1 1A-0000000198 Adoption
2 1A-0000000190 Cases Adoption
3 1A-0000000184 B Reports Adoption
in OCAF.
Home Tab

The Home page will be the initial screen presented each time you login to OCAF. It will display:

The list of Child Placement Applications (commonly known as the JFS 01691) submitted to
your agency.
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31 Ohio Certification f... “

Individual Applications

All of My Agency's Applications New

3+ items - Sorted by Application Number - Filtered by All individual applications - Record Type, Application Status « Updated a few seconds ago Search this list. #e |

3

|
( lication Nu... | v hold v | Applicatio... *»+  Application Stat... v | Most Recent Submis... v Agency v | Created Date V)

1A-0000000198 Stefany Household Adoption Withdrawn 2[14/2023 5:06 PM -
1A-0000000190 Stefany Household Adoption Agency Review 2/14/2023 12:22 PM Adoption Circle 2/14/2023 12:15 PM v

|A-0000000184 Smith Household Adoption Agency Review 2[13/2023 5:43 PM Adoption Circle 2/13/2023 11:35 AM v

The grid across the top will provide helpful information about each record:

Application Number — Clicking this blue hyperlink will navigate you into the Individual
Application record

Household - Clicking this blue hyperlink will navigate you to the Applicant's Household
record

Application Type - Each submitted application will have a designation for Foster Care,
Foster Care and Adoption, or Adoption.

Application Status — The system has multiple statuses which will indicate where in the
process each application is:

o Agency review: Application was submitted to your agency and needs to be
reviewed for approval.

o Incomplete: Your agency has reviewed the application and returned it to the
applicant(s) as it was incomplete.

o Review Complete: Your agency has reviewed the application and approved it.
Your final approval of the application starts the clock for the Home Study to be
completed.

o Withdrawn: The applicant may withdraw an application if they choose not to
move forward in applying or becoming licensed.

o Withdrawn - Closed by Agency: The application was previously completed, but
the applicant has decided to withdraw the application. Agency helped the
Applicant Withdraw the already approved application.

Most Recent Submission Date/Time — Documents the day and time when the
application was last/most recently submitted.
Agency - Indicates the Agency name the application was submitted to.

Created Date/Time - Documents the day and time that the application was initially
created by the applicant.

On the Home page, users will also find the OCAF Dashboard where the system displays high
level Application and Inquiries statistics for their Agency. The dashboard visualizes the number
of Applications and Inquiries within each status. To get more details about the application or
inquiry, users can click on the View Report link under each of the widgets.
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Dashboard
C;éA;abashboard . open m v

Heme Page Dashboeard containing Agency, Individual Applications, and Inguiries
As of Feb 15, 2023 4:45 PM - Viewing as Heidi Gatwood

Total Applications with Status Breakdown Total Inquiries with Status Breakdown

A New Leat, Inc. Email Sent
P
E A New Leaf, Inc. Agency Review
z

User Enrolled

Status > Agency Name

=
o
c
2
A
]
2
A
@
c
=]
"
o
=
o
<

Application Status Agency Review Status Email Sent ) User Enrolled

View Report (Total Applications with Status Breakdown} Wiew Report (Total Inquiries with Status Breakdown)

Number of Active Agencies Report =
Account Name T OCAF Agency Function
A New Leaf, Inc. Foster Care
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Accounts Tab

The Accounts tab will display active households that have submitted an application to your
agency.

H Department of
Ohio S Family Services Q Search...
it Ohio Certification f... ‘ Accounts s v
Aoeors New | Discov
OCAF Household Accounts v
28 items - Sorted by Account Name « Filtered by All accounts - Status, Account Record Type » Updated a few seconds ago Search this list
Account Name 1 ~ | Household Number v | status ~ | Mailing Street ~ | Mailing City ~ | Mailing StatefProvince | Mailing Zip[Postal ...
1 100 N Main St Household +H0000048288 New
2 6288 Jeffrelyn Drive Household H0000048309 Active 6288 Jeffrelyn Drive Hilliard Ohio 43026
3 666 Jeffrelyn Drive Household H0000048316 Active 666 Jeffrelyn Drive Hilliard Ohio 43026
a 6699 Jefirelyn Drive Household H0000048318 Active 6699 Jefirelyn Drive Hilliard Ohio 43026
5 699 Jeffrelyn Drive Household +H0000048320 Active 699 Jeffrelyn Drive Hilliard Ohio 43026

Individual Applications Tab

The Individual Applications tab displays a list of the applications submitted to your agency.
Ohio j‘:{‘-ﬂ;‘-ﬁ-;‘y&wim Q Search...

Ohio Certification f... ‘ Individual Applications ) v

Individual Applications

All of My Agency's Applications v ¥

45 items - Sorted by Application Number - Filtered by All individual applications - Record Type, Application Status - Updated a few seconds ago

Application Number 4 ~ | Household | Application Type ~ | Application Status “ | Most Recent Submission Da... v | Agency

1 |A-0000000203 Smith Household Adoption Agency Review 2/15/2023 4:44 PM A New Leaf, Inc.

Cases Tab

The Cases tab displays inquiries submitted online or by agency workers for your specific
agency.

Ohio e Famity Services Q Search..
31 Ohio Certification f... ( Cases j o
Cases

All My Agency's Inquiries v %
50+ items - Sorted by Case Number - Filtered by All cases - Case Record Type - Updated a few seconds ago

Case Number + “ | First Name ~ | Last Name ~ | Email v | Agency Name

1 00642988 John Doe jehndoe@sample.com Adopt America Network (former Midwest)
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Reviewing an Application

From the Home tab or the Individual Applications tab, click on the application number to open
the submitted application.
Ohio i'&"'.m':,sw Q Search...

Ohio Certification f... t Individual ApplicationSi ~

Individual Applications

All of My Agency's Applications v %

45 items - Sorted by Application Number - Filtered by All individual applications - Record Type, Application Status - Updated a few seconds ago

Application Number + v | Household v ‘ Application Type | Application Status ~ | Most Recent Submission Da... | Agency
1 1A-0000000203 Smith Household Adoption Agency Review 2/15/2023 4:44 PM A New Leaf, Inc.

The Application’s Details tab appears, along with a bar of additional tabs to guide you through
the entire Application.

Assign the Application

Update the Ownership of the Application to assign for review. On top of the application page,
click on the Change Owner button.

Individual Application -
1A-0000000203 + Folow ( Change Owner ) NewNote

Household Application Type Application Status Most Recent Submission Date/Time Record Type Owner Name
Smith Household Adoption Agency Review 2/15/2023 4:44 PM OCAF Application ANew Leaf, Inc. £

Search and select your name, or the name of the individual you wish to assign, and click
Submit. The application is now successfully assigned.

Change Individual Application Owner

v heidi

Q  "heidi" in Users
"1 Heidi Gatwood

7] Heidi Turner

© Notes and attachments

© Open activities

Cancel
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Details

The Details Tab will contain Household information, Agency information, Applicant Signatures,
and general submission information.

Details Applicants Household Members Home Arrangements Interest & Experience References
Household Application Status
Smith Household Agency Review
Initial Submissicn Date/Time €@ Reason withdrawn by Agency
2/15/2023 4:44 PM
Most Recent Submission Date/Time € Agency
2/15/2023 4:44 PM A New Leaf, Inc.
Date Application Review Completed Application Type
Adoption
Submission Count € How were you Referred to Agency

1
All Applicant Names
Charles Smith

Directions to Your Home from Agency

v Applicant Signatures

Applicant 1 Signature Applicant 4 Signature
Applicant 1 Signature Name Applicant 4 Signature Name
Applicant 1 Signed Date Applicant 4 Signed Date
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Applicants

Under the Applicants Tab, you will see background history of all applicants. By default,

Applicant 1’s section opens up. Click on each Applicant’s accordion to expand their information.
Each Applicant’s tab will contain the following sections:

Applicant

Military History

Criminal History
Residential History
Employment History
Marital/Relationship History

Review each section for every Applicant. Each blue hyperlink below will navigate you to
additional details entered by the respective Applicant.

Details Applicants Household Members Home Arrangements Interest & Experience References

v Applicant 1

E Applicant 1 (1)

Applicant Name T First Name ~ | Last Name ~ | Email Address ~ | Cell Phone v

A-000275 Charles Smith &% charles.smith@sample.com (1171) 1M1-111

Military History (1)

Background History Name Military Branch v | Date Entered Military | Date Discharged ~ | Type of discharge “ | Explanation for Other...

Navy 2/1/2023 2/28/2023 Other Example Other

Criminal History (1)

Background History ... | Offense ~ | City of Offense “ | State of Offense v | Convicted? v | Date of Convictio... » | Sentence v

B-000879 Example Offense 1 Columbus OH Yes 212023 Sentence Example Here

Residential History (2)
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Household Members

The Household Members Tab will display all
demographics and criminal history (if entered).

Review Household Member information. Each

cy User Guide

Household Members, including their

blue hyperlink below will navigate you to

additional details entered for the household member.

Details

Applicants Household Members Home Arrangements

[E] Household Members (1)

Applicant Name First Name » | Last Name
Jessica Smith
@ Criminal History (0)
No Records

Home Arrangements

Under the Home Arrangements Tab, you will
Description of Home, and Vehicles.

Interest & Experience References

» | Email Address ~ | Cell Phone

X jessica.smith@sample.com

Found !

see information on Sleeping Arrangements,

Review the Home Arrangement Information. Each blue hyperlink below will navigate you to
additional details regarding the sleeping arrangement/room description.

Details Applicants Household Members Home Arrangements Interest & Experience References
Sleeping Arrangements (1) New
OCAF Sleeping Arrangement Name Bedroom Number Floor/Level Occupant(s)
1 Second Charles -

View All

m Description of Home

Does any family member smoke?
No

Ara there any pets in the home?
Yes

Do pats mest local safety raquiraments? @
No

Do you operate Business from residence?
Yes

Business Description

Online Business

Applicant(s) have living adult children?
No

m Vehicles

Type of Vehicles

One Gar
Ara vehicles in operable condition’

Yes

Ara thera infant car seats?
No

Page 11 of 16

Ohio

Department of
Job and Family Services

Is smoking allowed in the house?
Na
Description of Pet(s]

Dog

Explain if Safety Requirements not met
Vaccination

Adult/Child Care or Rooming House?
Yes

Business Impact on Foster/Adopt Plan
No Impact

Willing to obtain Crib?

Yes

If Vehicle not Operable, please explain
Not Applicable

Are there toddler car seats?

No

Proaf of Insurance for all vehicles?

Yes

Huse Milas tn nasrast Rus ns Transit
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Interest & Experience

Under Interest & Experience Tab, you will see the application details of Type of Child
Considered and Experience with Children to review.

Details Applicants Household Members Home Arrangements ‘ Interest & Experience ’ References

E Type of Child Considered v
Age Range Number of children

12-15 Three or more

Gender

Male;Female

Are you applying for specific child? Name of Specific Child

Yes Jessica Stefany

Is Child related by Blood or Marriage? Specify Relationship if Applicable

Yes Previous Daughter

a Experience with Children v
Applied/Certified as Foster in any State Applied/Approved to Adopt in any State

Yes

Details of Previous Adoption/Foster

Household Member apply/certify Foster Household Member and Foster Agency

Yes

Household Member applyfapprove Adoption Household Member and Adoption Agency

Yes #
Experience with Child Welfare Agencies? Details of Child Welfare Experience

Yes

Experience with Children (not your own)

References

The References Tab will list Relative and Non-Relative References and Adult Child
References if applicable.

Review the Reference Information. Each blue hyperlink will navigate you to additional details
regarding the referent.

Details Applicants Household Members Home Arrangements Interest & Experience

c References (3)

OCAF Referrences Name Reference Name v | Reference Type v | Reference Relationship | Reference Email v | Reference Phone 3
Person 1 Non-Relative Reference Friend % person1@test.com (319) 610-5066

R-0000118 Person 2 Non-Relative Reference Friend % person2@test.com (319) 610-5066

R-0000119 Person 3 Relative Reference Brother % person3@test.com (319) 810-5066

[ Adult Child References (1)

OCAF Referrences Name Reference Name w | Adult Child Reference Relationship v

R-0000120 Paddington Smith Adoptive Child
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Files

Additionally, an Agency Worker can find an Exported Application PDF (Form 01691) as well as
supporting documents submitted by the applicant under Files on the right side of the application

page.
To open the content of the application, click on the title of the document. A previewer will load
the content within the system.

Files (1)

JF5-01691
=0l Feb 15, 2023 - 144KB - pdf

View All
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Approving/Returning an Application

After a full review of all the tabs and links in the application:

1. Return to the Details tab of the Application.
Click the pencil icon next to or double click the Application Status field.

3. Select the appropriate Status selection. The checkmark on the top bar will indicate the
current status.

e Choose Incomplete if there are things missing and you need applicant(s) to add
more information. This will return the application to the applicant so they can
complete your suggested requirements.

e Alternatively, select Review Complete if, after review, all details are complete
and accurate. This will lock the application and make it view only.

Individual Application
1A-0000000203

Housenold Application Type Application Status Most Recent Submission DatefTime Record Type Owner Name

Smith Household Adoption Agency Review 2/15/2023 4:44 PM OCAF Application ’_" Heidi Gatwood £

Application Status: Agency Review

\

Applicants Household Members Home Arrangements Interest & Experience References

[ smith Household x Agency Review v

~-None--
Initial Submission Date/Time €
2/15/2023 4:44 PM

New
+ Agency Review
Incomplete

Most Recent Submission Date/Time €@ Withdrawn

2/15/2023 4:44 PM
Review Complete

Withdrawn - Closed by Agency
Cancel I

4. After selecting your Status, click Save.

5. A system generated email will be sent to Applicant(s) based on the updated status. This
will be the indicator to the applicant(s) of application status.

. Department of
Oth Job and Family Services

Thank you for submitting the following Child Placement Application:

« Application Number: IA-0000000203

« Application Type: Adoption

« Agency: A New Leaf, Inc.

« Date Application Submitted: 2/15/2023 4:44 PM

The Agency listed above has reviewed your Application and determined it
is "Incomplete”.

The Agency will be contacting you soon for further information needed on
your Application.

Click on this link to access your Application: https://odjfs2--
ocafomni.sandbox.my.site.com/OCAFApplicant

6. Once the application has been marked as Review Complete, proceed in Ohio SACWIS
with next steps to begin the Home Study process.
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Sending an Email to Applicant(s)

1. From the Individual Application Details page, view the right side of the screen. There is
a section for Activity and Chatter. Within the Activity tab, click where it says Write an
Email ...

Activity Chatter
Email

Filters: All time - All activities - All types %

Refresh « Expand All - View All

“ Upcoming & Overdue

No activities to show.
Get started by sending an email, scheduling a task, and more.

Mo past activity. Past meetings and tasks marked as done show up here.

2. Add an email address in the To section. As you start typing, it may pop into the box for
you. Select the desired email recipients.

Email

*From -

charles smith

Charles Brown Smith
charles.smith@sample.com

w

Enter the Subject of the email.

Enter details in the text of the email, such as missing items on the application, clarifying
questions on the information entered, or next steps after you have reviewed the
application.

5. Click Send. The emails will stay with this Application record within the system.

s
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To charles smith X Ce
Bee
Eubiect Recent Application was marked incomplete )
[t J[see  -][B 1 ula-@][=:= 2= 2|
(=][e]
(" Thank you for your submitted application. )

After review, I will need more information from you on the application around
your criminal history and any adult children you may have.

After you have revised, please return for agency review.
Thank you,

A New Leaf, Inc.

\ v

¢ up 86O

Related To

[E] 12-0000000203 x @

6. Click the Home tab to return to your list of applications.

If you need additional technical information or assistance with the OCAF functionality,
please contact the OFC Automated Systems Help Desk at
SACWIS HELP DESK@jfs.ohio.gov .
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